## Contents

This PDF is entirely searchable. From the toolbar menu, choose Edit > Find or Search to begin your search. You can also click on an entry or page number in the Contents list below to jump to a selected section.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>References and Sources</td>
<td>3</td>
</tr>
<tr>
<td>Proper Names at Rutgers</td>
<td>4</td>
</tr>
<tr>
<td>– Rutgers Entities</td>
<td>5</td>
</tr>
<tr>
<td>– Queen’s College and Old Queens</td>
<td>6</td>
</tr>
<tr>
<td>– School and College Names</td>
<td>7</td>
</tr>
<tr>
<td>– Acronyms/Initialisms (School/Center Abbreviations)</td>
<td>12</td>
</tr>
<tr>
<td>– Other Unit Names</td>
<td>13</td>
</tr>
<tr>
<td>Addresses, States, Municipalities, and Countries</td>
<td>15</td>
</tr>
<tr>
<td>Alphabetization</td>
<td>16</td>
</tr>
<tr>
<td>Athletics</td>
<td>16</td>
</tr>
<tr>
<td>Capitalization</td>
<td>17</td>
</tr>
<tr>
<td>Electronic Media</td>
<td>20</td>
</tr>
<tr>
<td>Gender-Specific Language</td>
<td>22</td>
</tr>
<tr>
<td>Governing Boards</td>
<td>23</td>
</tr>
<tr>
<td>Italics</td>
<td>23</td>
</tr>
<tr>
<td>LGBTQA Language</td>
<td>24</td>
</tr>
<tr>
<td>Numbers</td>
<td>25</td>
</tr>
<tr>
<td>– Telephone Numbers</td>
<td>26</td>
</tr>
<tr>
<td>Plurals and Possessives</td>
<td>26</td>
</tr>
<tr>
<td>Preferred Spellings, Capitalizations, Usage</td>
<td>28</td>
</tr>
<tr>
<td>Punctuation</td>
<td>34</td>
</tr>
<tr>
<td>– Bulleted and Numbered Lists</td>
<td>34</td>
</tr>
<tr>
<td>– Commas</td>
<td>35</td>
</tr>
<tr>
<td>– Dashes and Hyphens</td>
<td>36</td>
</tr>
<tr>
<td>– Hyphenation</td>
<td>37</td>
</tr>
<tr>
<td>– Internal and Terminal Punctuation</td>
<td>38</td>
</tr>
<tr>
<td>– Parentheses</td>
<td>39</td>
</tr>
<tr>
<td>– Periods and Other Terminal Punctuation</td>
<td>39</td>
</tr>
<tr>
<td>– Quotation Marks</td>
<td>39</td>
</tr>
<tr>
<td>– Semicolons and Colons</td>
<td>39</td>
</tr>
<tr>
<td>State References</td>
<td>40</td>
</tr>
<tr>
<td>Style Guide Exceptions for News Media</td>
<td>41</td>
</tr>
<tr>
<td>Style Guide Exceptions for Websites</td>
<td>41</td>
</tr>
</tbody>
</table>
Introduction

The following editorial guidelines have been developed for Rutgers, The State University of New Jersey, in order to lend consistency to text presentation in university print and electronic communications.

The primary purpose of this guide is to address topics specific to Rutgers that may not be adequately covered in the standard published style guides, such as *The Chicago Manual of Style* or *The Associated Press Stylebook* (see below). In addition, the guide summarizes some of the most frequently raised questions of style—topics that are dealt with in greater detail in these manuals—in order to offer a quick, but more comprehensive, reference tool.

Questions of style, unlike many questions of grammar, usually do not have a “right” or “wrong” answer. Instead, establishing a “preferred” style is helpful so that a consistent presentation can be maintained throughout an array of materials that may be produced by many different individuals. Having a set of predetermined guidelines can also save those individuals the time and energy required to develop their own guidelines.

Exceptions to university style that apply to materials intended for distribution to the news media and materials created for websites may be found on page 41.

References and Sources

Note that editorial style reference works frequently contradict one another. In addition to the two primary sources listed below, many professional organizations have specialized style sheets for their specific disciplines, as do academic journals. You need to choose the style reference that is appropriate for your discipline and communications format.

Style Guides

- *The Chicago Manual of Style* (15th or 16th Edition)
  Used for books, brochures, catalogs, reports, and websites. The creative services office of the Department of University Communications and Marketing relies primarily on this source. A revised (16th) edition was published in 2010. Because the 16th edition is not readily available at Rutgers, the 15th edition remains acceptable.
- *The Associated Press Stylebook and Briefing on Media Law*
  Used for newspapers, media, etc. The university news and media relations office of the Department of University Communications and Marketing relies primarily on this source.

Dictionaries

- *Webster’s Third New International Dictionary and Supplements*
  Springfield, MA: Merriam-Webster Inc., updated frequently. (Not as comprehensive, but because it is updated more frequently, it contains recent usage changes. If these two sources contradict one another, the second is preferred.)

Grammar Guide


Additional Resources

- *Rutgers Fact Book*
- *Commission on Higher Education Inventory of Degree and Certificate Program Offerings at New Jersey Institutions of Higher Education*
Proper Names at Rutgers

*Rutgers, The State University of New Jersey,* is a public research university with three higher education institutions—Rutgers University–New Brunswick, Rutgers University–Newark, and Rutgers University–Camden—and an academic health care division, Rutgers Biomedical and Health Sciences, which collaborates universitywide and is aligned with Rutgers University–New Brunswick.

**Rutgers, The State University of New Jersey**

1. Capitalization: Note that the word “The” is capitalized.

2. Punctuation:

   a. “Rutgers” is followed by a comma, not a dash.

   b. When used in text, the full name of the university is followed by a comma, treating the phrase “The State University of New Jersey” as an appositive.

   Example: Rutgers, The State University of New Jersey, is the eighth oldest institution of higher learning in the United States.

   c. “The State University of New Jersey” as a stand-alone phrase is capitalized when beginning a sentence or when used later in a sentence.

   Example: Rutgers is The State University of New Jersey, and as such …

3. When to Use: The name “Rutgers, The State University of New Jersey,” should be used in those instances when you are referring to the university as a whole or to the central administration of the university. The full name should be used in copyright notices to ensure that appropriate rights and protections extend to the full university. The full name may also appear in website footers, addresses, or other instances where a formal designation is appropriate.

4. Possessive (also see Plurals and Possessives on page 26):

   a. Use an apostrophe only with the word “Rutgers.” Do not add an extra “s.”

   Example: Rutgers’ chess team was founded in 1768.

   b. When used as a possessive, i.e., with an apostrophe after the “s,” the word “Rutgers’” is never preceded by “the.”

   c. When used as an adjective, the word “Rutgers” may or may not be preceded by “the,” depending on the noun it modifies and the meaning of the sentence.
Examples: In general, Rutgers students are a loyal bunch. The Rutgers students did well.

Helpful Hint: When Rutgers precedes a noun, either as an adjective or as a possessive, never put a “the” before Rutgers and an apostrophe after the “s.”

Helpful Hint: If you are not sure whether “Rutgers” should be possessive in a particular usage, substitute a name that does not end in “s,” such as Yale, and see whether it makes sense or whether the substitution requires you to add an “s,” e.g., “Yale’s.”

Rutgers Entities

1. Rutgers University–New Brunswick on first reference; Rutgers–New Brunswick or Rutgers on subsequent references is acceptable.

Rutgers Biomedical and Health Sciences on first reference; “division” may be added for clarity, e.g., the Rutgers Biomedical and Health Sciences division. This division collaborates universitywide and is aligned with Rutgers University–New Brunswick.

Rutgers University–Newark on first reference; Rutgers–Newark on subsequent references is acceptable.

Rutgers University–Camden on first reference; Rutgers–Camden on subsequent references is acceptable.

a. Use a closed en dash between Rutgers University and the city (as is used above). Do not use an em dash (longer) or a hyphen (shorter). See Dashes and Hyphens on page 36.

2. Rutgers Health

Rutgers Health, an academic health care provider organization with locations across New Jersey, is the clinical arm of the university and includes the areas of Rutgers Biomedical and Health Sciences and other Rutgers units devoted to caring for patients.

3. Appropriate Rutgers Name

a. The appropriate Rutgers name must appear somewhere in all official Rutgers communications.

b. When referring specifically to Rutgers University–New Brunswick, Rutgers Biomedical and Health Sciences, Rutgers University–Newark, Rutgers
University–Camden, or Rutgers Health, use the correlating logo/signature. The Rutgers and Rutgers, The State University of New Jersey, logos/signatures should be used for communications from/about the central administration and governing boards or when referencing more than one entity.

4. Rutgers University–New Brunswick is made up of five smaller campuses:
   - Busch Campus
   - College Avenue Campus
   - Douglass Campus
   - George H. Cook Campus (G.H. Cook is also acceptable)
   - Livingston Campus

   a. Also used, especially on maps: Cook/Douglass Campus (although these are considered to be two distinct campuses)

   b. Note the appropriate alphabetical order for the New Brunswick campuses:
      Busch Campus, College Avenue Campus, Douglass Campus, George H. Cook Campus, Livingston Campus.

   *Queen’s College and Old Queens*

   Queen’s College refers to the original name of Rutgers and is acceptable. Note that there is an apostrophe in Queen’s College.

   Old Queens Campus is acceptable if in a historical reference; otherwise, do not use. Note that there is no apostrophe in Old Queens Campus.

   Old Queens Building is acceptable. When referring to the building on second reference, Old Queens is acceptable. Note that there is no apostrophe in Old Queens Building or Old Queens.
School and College Names

1. As of July 31, 2015, there are 31 schools and colleges at Rutgers, The State University of New Jersey. The word “Rutgers” may be placed before the name of the college or school, except in cases where it is part of the name (Rutgers School of Dental Medicine, Rutgers Law School, and Rutgers Business School–Newark and New Brunswick).

1. Camden College of Arts and Sciences *
2. Edward J. Bloustein School of Planning and Public Policy ***
3. Ernest Mario School of Pharmacy *** (see note below)
4. Graduate School–Camden **
5. Graduate School–New Brunswick **
6. Graduate School–Newark **
7. Graduate School of Applied and Professional Psychology **
8. Graduate School of Biomedical Sciences **
9. Graduate School of Education **
10. Mason Gross School of the Arts ***
11. New Jersey Medical School **
12. Newark College of Arts and Sciences *
13. Robert Wood Johnson Medical School **
14. Rutgers Business School–Newark and New Brunswick *** (see note below)
15. Rutgers Law School** †
16. Rutgers School of Dental Medicine **
17. School of Arts and Sciences *
18. School of Business–Camden ***
19. School of Communication and Information ***
20. School of Criminal Justice ***
21. School of Engineering *
22. School of Environmental and Biological Sciences *
23. School of Health Professions ***
24. School of Management and Labor Relations ***
25. School of Nursing ***
26. School of Nursing–Camden ***
27. School of Public Affairs and Administration ***
28. School of Public Health **
29. School of Social Work **
30. University College–Camden *
31. University College–Newark *

*Undergraduate programs
**Graduate programs
***Both undergraduate and graduate programs

† The School of Law–Newark and School of Law–Camden were merged and became Rutgers Law School on July 31, 2015.
Ernest Mario School of Pharmacy
This school is considered an undergraduate school because it admits students as first-year students directly from high school into its six-year doctor of pharmacy degree program. Therefore, it is listed as “Both.”

Rutgers Business School–Newark and New Brunswick
“Rutgers Business School–Newark and New Brunswick” is the preferred umbrella name used in most cases to identify students, faculty, programs, etc., connected to the university’s three formal degree-granting units that offer business programs in Newark and New Brunswick:

- Rutgers Business School: Undergraduate–Newark
- Rutgers Business School: Undergraduate–New Brunswick
- Rutgers Business School: Graduate Programs–Newark and New Brunswick

In general, always use “Rutgers Business School–Newark and New Brunswick.” You may use the formal nomenclature if preparing a formal report for a chancellor or vice president, for instance, and you need to make a distinction between programs. But for general audiences use the umbrella name. To make distinctions, consider specifying “the bachelor of science program at Rutgers Business School–Newark and New Brunswick,” for example. Never use “Rutgers Business School–Newark” or “Rutgers Business School–New Brunswick.”
2. School names do not include “The” (cap “T”) as part of their name. You may, however, when appropriate, use “the” (lowercase “t”) to precede the name of some of the schools in text.

3. The word “Rutgers” before the name of a school or college may or may not include an apostrophe depending on the writer’s preference. Notable exceptions are Rutgers Business School–Newark and New Brunswick, Rutgers Law School, and Rutgers School of Dental Medicine, which never take an apostrophe.

Examples: Rutgers’ School of Criminal Justice is based in Newark. The professor presented his seminar at the Rutgers School of Social Work.

4. Use a closed en dash in the name of the school (as is used in the list on page 7). Do not use an em dash (longer) or a hyphen (shorter).

Examples: University College–Camden, Graduate School–New Brunswick

To insert an en dash in Word:
PCs: From the menu, choose Insert > Special Character, then choose the en dash (the smaller of the two dash options). The shortcut is Control + Numberpad Minus Sign (-).

MACs: From the menu choose Insert > Symbol, then choose the en dash (the smaller of the two dash options). The shortcut is Command (Apple) + Numberpad Minus Sign (-).

5. Always use the full name of the school or college on first reference. On second reference and thereafter, it is preferable to use “the school” or “the college,” with distinctions made if necessary, e.g., “the psychology school.” Avoid acronyms and initialisms on second, and later, references.

On second reference, Mason Gross is acceptable for the Mason Gross School of the Arts and the Bloustein School is acceptable for the Edward J. Bloustein School of Planning and Public Policy.

If you must use an acronym/initialism in text for brevity’s sake, reference the full name at the first mention, followed by the acronym/initialism in parentheses. Acronyms are not preceded by “the” while initialisms often are. Contact the dean’s office of the school or college to determine the preferred acronym or initialism.

See full discussion of acronyms and initialisms on page 12.
Schools and Colleges by Location

Note: Some schools and colleges offer programs at multiple sites.

**Rutgers University–New Brunswick** (includes facilities in New Brunswick, Piscataway, and several surrounding municipalities)
- Edward J. Bloustein School of Planning and Public Policy
- Ernest Mario School of Pharmacy (part of RBHS)
- Graduate School of Applied and Professional Psychology
- Graduate School of Education
- Graduate School–New Brunswick
- Mason Gross School of the Arts
- Rutgers Business School–Newark and New Brunswick
- School of Arts and Sciences
- School of Communication and Information
- School of Engineering
- School of Environmental and Biological Sciences
- School of Management and Labor Relations
- School of Nursing (part of RBHS)
- School of Social Work

**Rutgers Biomedical and Health Sciences** (collaborates universitywide and is aligned with Rutgers University–New Brunswick, has facilities in New Brunswick, Piscataway, Newark, Scotch Plains, Somerset, Stratford, and Blackwood)
- Ernest Mario School of Pharmacy
- Graduate School of Biomedical Sciences
- New Jersey Medical School
- Robert Wood Johnson Medical School
- Rutgers School of Dental Medicine
- School of Health Professions
- School of Nursing
- School of Public Health

**Rutgers University–Newark**
- Graduate School–Newark
- Newark College of Arts and Sciences
- Rutgers Business School–Newark and New Brunswick
- Rutgers Law School
- School of Criminal Justice
- School of Nursing (part of RBHS)
- School of Public Affairs and Administration
- School of Social Work
- University College–Newark

**Rutgers University–Camden**
- Camden College of Arts and Sciences
Graduate School–Camden
Rutgers Law School
School of Business–Camden
School of Nursing–Camden
School of Social Work
University College–Camden
Acronyms/Initialisms (School/Center Abbreviations)

1. Use acronyms and initialisms sparingly. The preference is to spell out school, college, center, and institute names in full and to avoid using acronyms, initialisms, abbreviations, or shortened names. An acronym is an abbreviation formed from a series of letters read as a word (e.g., NASA, for National Aeronautics and Space Administration), while an initialism is an abbreviation formed from a series of letters read as a series of letters (e.g., USDA, for United States Department of Agriculture).

2. In general, it is preferable to use “the school” on second reference, with distinctions made if necessary, e.g., “the psychology school.” Although schools and colleges tend to rely on acronyms and initialisms in their own materials, be mindful that readers may not understand the abbreviations and that full names immediately convey the scope and nature of the school.

Note: On second reference, Mason Gross is acceptable for the Mason Gross School of the Arts and the Bloustein School is acceptable for the Edward J. Bloustein School of Planning and Public Policy.

3. When referring to a center or institute, it is always preferable to refer to “the center” or “the institute” on second reference. Rely on acronyms/initialisms only when dealing with more than one center or institute. If you need to use the acronym/initialism in text for brevity’s sake, reference the full name at the first mention, followed by the acronym/initialism in parentheses. Acronyms are not preceded by “the” while initialisms often are.

Examples:
The Mason Gross School of the Arts is an arts conservatory. Established in 1976, the school offers professional degrees in several artistic disciplines.

Catherine studied under a faculty member at the Institute for Advanced Materials, Devices, and Nanotechnology. The institute was established in 2005.

The Center for American Women and Politics (CAWP) and the Center for Cultural Analysis (CCA) jointly sponsored the seminar. CAWP hosted the Friday sessions, and the CCA sponsored the Saturday sessions.

4. Acronyms and Initialisms When Referring Specifically to Students and Alumni with School or College and Year of Graduation

When citing a person’s school or college and year of graduation after his or her name, the standard form is the name of the school, followed by a space, followed by an apostrophe and the last two digits of the year. Note that this is one case where acronyms and initialisms are acceptable. Close up the space between the acronym/initialism and the year.
Examples:
John Smith, Graduate School of Education ’56
John Smith GSE’56
John GSE’56 and Jane GSNB’58 Smith

For clarity, use the whole year when referring to early- or late-century class years.

Example: Queen’s College 1805, Rutgers College 1905, QC1805, RC1905

5. List of School and College Acronyms/Initialisms

**NOTE:** Use only when referring specifically to students and alumni with school or college and year of graduation. For guidance regarding acronyms and initialisms for schools and colleges from earlier years at Rutgers, contact the Department of Alumni Relations, 848-932-7490.

<table>
<thead>
<tr>
<th>CC</th>
<th>Cook College</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCAS</td>
<td>Camden College of Arts and Sciences</td>
</tr>
<tr>
<td>CLAW</td>
<td>School of Law–Camden</td>
</tr>
<tr>
<td>DC</td>
<td>Douglass College</td>
</tr>
<tr>
<td>ED</td>
<td>School of Education</td>
</tr>
<tr>
<td>EJB</td>
<td>Edward J. Bloustein School of Planning and Public Policy</td>
</tr>
<tr>
<td>ENG</td>
<td>School of Engineering</td>
</tr>
<tr>
<td>GSAPP</td>
<td>Graduate School of Applied and Professional Psychology</td>
</tr>
<tr>
<td>GSBS</td>
<td>Graduate School of Biomedical Sciences</td>
</tr>
<tr>
<td>GSC</td>
<td>Graduate School–Camden</td>
</tr>
<tr>
<td>GSE</td>
<td>Graduate School of Education</td>
</tr>
<tr>
<td>GSM</td>
<td>Graduate School of Management</td>
</tr>
<tr>
<td>GSN</td>
<td>Graduate School–Newark</td>
</tr>
<tr>
<td>GSNB</td>
<td>Graduate School–New Brunswick</td>
</tr>
<tr>
<td>LC</td>
<td>Livingston College</td>
</tr>
<tr>
<td>MGSA</td>
<td>Mason Gross School of the Arts</td>
</tr>
<tr>
<td>NCAS</td>
<td>Newark College of Arts and Sciences</td>
</tr>
<tr>
<td>NJDS</td>
<td>New Jersey Dental School</td>
</tr>
<tr>
<td>NJMS</td>
<td>New Jersey Medical School</td>
</tr>
<tr>
<td>NLAW</td>
<td>School of Law–Newark</td>
</tr>
<tr>
<td>NUR</td>
<td>College of Nursing</td>
</tr>
<tr>
<td>PHARM</td>
<td>Ernest Mario School of Pharmacy</td>
</tr>
<tr>
<td>QC</td>
<td>Queen’s College</td>
</tr>
<tr>
<td>RBS</td>
<td>Rutgers Business School–Newark and New Brunswick</td>
</tr>
<tr>
<td>RC</td>
<td>Rutgers College</td>
</tr>
<tr>
<td>RLAW</td>
<td>Rutgers Law School</td>
</tr>
<tr>
<td>RSDM</td>
<td>Rutgers School of Dental Medicine</td>
</tr>
<tr>
<td>RWJMS</td>
<td>Robert Wood Johnson Medical School</td>
</tr>
<tr>
<td>SAS</td>
<td>School of Arts and Sciences</td>
</tr>
<tr>
<td>SB</td>
<td>School of Business</td>
</tr>
<tr>
<td>SBC</td>
<td>School of Business–Camden</td>
</tr>
<tr>
<td>SC&amp;I</td>
<td>School of Communication and Information</td>
</tr>
<tr>
<td>SCILS</td>
<td>School of Communication, Information, and Library Studies</td>
</tr>
<tr>
<td>SCJ</td>
<td>School of Criminal Justice</td>
</tr>
<tr>
<td>SEBS</td>
<td>School of Environmental and Biological Sciences</td>
</tr>
<tr>
<td>SHP</td>
<td>School of Health Professions</td>
</tr>
<tr>
<td>SHRP</td>
<td>School of Health Related Professions</td>
</tr>
<tr>
<td>SMLR</td>
<td>School of Management and Labor Relations</td>
</tr>
<tr>
<td>SN</td>
<td>School of Nursing</td>
</tr>
<tr>
<td>SNC</td>
<td>School of Nursing–Camden</td>
</tr>
<tr>
<td>SPAA</td>
<td>School of Public Affairs and Administration</td>
</tr>
<tr>
<td>SSW</td>
<td>School of Social Work</td>
</tr>
<tr>
<td>UCC</td>
<td>University College–Camden</td>
</tr>
<tr>
<td>UCN</td>
<td>University College–Newark</td>
</tr>
<tr>
<td>UCNB</td>
<td>University College–New Brunswick</td>
</tr>
</tbody>
</table>

**Other Unit Names**

1. Capitalize the formal, full names of centers, bureaus, institutes, academic departments, administrative offices, and other formal groups, such as boards or committees. Use the full name of the unit on first reference. Lowercase shortened names or casual references.
used thereafter. Always capitalize proper nouns in formal or casual references, e.g., the Department of English, the English department.

Department and administrative office names at Rutgers are almost always “Department of” or “Office of.” Exceptions are the Rutgers University Police Department, Rutgers Athletics, Rutgers Recreation, and Rutgers University Libraries.

Examples: the Department of History, but the history department; the Department of English, but the English department; the Office of the Dean, but the dean’s office; the Office of University Undergraduate Admissions, but the admissions office or admissions; the Board of Governors, but the board.

Make sure that the university affiliation (Rutgers University–New Brunswick, Rutgers University–Newark, or Rutgers University–Camden) of the group described is obvious from the context of the material being prepared, e.g., the Department of Psychology at Rutgers University–Newark.

2. For units that are not colleges or schools but are identified by location in their formal names, use an en dash to separate the unit name from the location.

Examples: Faculty of Arts and Sciences–Newark, Faculty of Arts and Sciences–Camden, FAS–N, FAS–C

3. Rutgers Cancer Institute of New Jersey: Using the full name of the institute on the first reference is the preferred style. On second reference and thereafter, Cancer Institute of New Jersey is preferred. You may also use the Cancer Institute in subsequent references, but avoid abbreviations such as ČINJ, except for limited internal communications.
Addresses, States, Municipalities, and Countries

1. Commas are used in text to set off individual elements in addresses and names of geographical places or political divisions. The standard U.S. Postal Service abbreviation for a state or country should be used when providing addresses primarily for the purpose of mailing or in citations. (Use only one space, not two, between the state and the zip code.) Otherwise, states and countries should be spelled out in full. Note that “D.C.” in running text is used with periods but “DC” in an address for mailing purposes is used without periods.

Examples:
Please send all proofs to the editor at 25 Bentley Drive, New Brunswick, NJ 08901.

The plane landed in Nairobi, Kenya, that evening.

2. When referring in general to a municipality, city, or state, the word “city” or “state” is not capitalized when it precedes a place name, but when referring specifically to an official governmental function/action of the municipality, city, or state, “city” or “state” is capitalized when it precedes the place name.

Examples:
Visitors to the city of New Brunswick will notice new Rutgers banners hanging from utility poles.

The state of New Jersey is densely populated.

The City of New Brunswick approved Rutgers’ banner program at the council meeting.

The State of New Jersey issued new guidelines for teen drivers.

3. Rutgers return addresses should have a minimum of three lines. The bottom line should have the city, state, and zip code. The second from the bottom line should have the street address (a room/office/suite number can also appear on this line.) The third from the bottom line should have Rutgers, The State University of New Jersey. The name of the building, if any, should appear on the fourth from the bottom line. Other information, e.g., school, department, etc., should appear above that. Note that New Jersey is abbreviated (NJ) when used with a zip code. Note that Street, Avenue, etc., are spelled out in full.

Example:
School/Center
Building Name, Room or Suite Number (if any)
Rutgers, The State University of New Jersey
Street Address
City, State Zip
4. Email Signatures

Example:
Name
Title
Department/Division/Center
Building Name, Room or Suite Number (if any)
Rutgers, The State University of New Jersey
Street Address
Town, State Zip
p. xxx-xxx-xxxx
f. xxx-xxx-xxxx
email: name@rutgers.edu

**Alphabetization**

Preference is to use the letter-by-letter (as opposed to word-by-word) method to alphabetize.

Example of letter-by-letter order: Newark, New Brunswick, New York

Example of word-by-word order: New Brunswick, New York, Newark

**Athletics**

Style for commonly used athletics terms.

All-American
Big Ten or Big Ten Conference * (Always spell out “Ten”; never use “10.”)
Division I, Division II, Division III
Elite Eight
Final Four
Football Bowl Subdivision
Football Championship Subdivision
NCAA
NCAA championship
NCAA tournament
number-one team
on the Banks
Sweet Sixteen

A score of 6–8 (use an en dash)
Having a season record of 9-3 (use a hyphen)
* Place the ® (either superscript ® or subscript ®) after the first use in running text of the term Big Ten. Do not use the ® in a title or heading.

Example: Rutgers University–New Brunswick joined the Big Ten® Conference on July 1, 2014. In addition to being a member of the Big Ten, it is also a member of the Big Ten Academic Alliance (formerly known as the Committee on Institutional Cooperation).

Note: For questions regarding NCAA or Big Ten copyrights, trademarks, and other issues, contact Marybeth Schmutz [email mschmutz@ucm.rutgers.edu], Assistant Director for Trademark Licensing, Creative Services, Department of University Communications and Marketing.

**Capitalization**


2. Academic Subjects: Lowercase the names of subject areas in text, unless the name is a proper noun, such as French. Capitalize a subject when used as the name of a specific course or with its subject code or curriculum code.

Example: Sociology 01:920:201, Sociology 920. He double-majored in art and sociology.

3. University, College, and School: Lowercase university, college, and school unless they are used as part of a formal complete name.

Example: The School of Health Professions is part of Rutgers Biomedical and Health Sciences. The school offers majors in a wide variety of disciplines.

4. Titles of Organizations: Capitalize the formal, full names of centers, bureaus, institutes, academic departments, administrative offices, and other formal groups, such as boards or committees. Lowercase shortened names or casual references. Always capitalize proper nouns in formal or casual references. Department and administrative office names at Rutgers are almost always “Department of” or “Office of.” Exceptions include the Rutgers University Police Department and Rutgers University Libraries.

Example: the Department of History, but the history department; the Department of English, but the English department; the Office of the Dean, but the dean’s office; the Office of University Undergraduate Admissions, but the admissions office or admissions; the Board of Governors, but the board.

5. When multiple departments appear in a sentence, lowercase “department” but uppercase the unit names.
Example: The center facilitates interdisciplinary research among the departments of Earth and Planetary Sciences, Environmental Sciences, Geography, and Marine and Coastal Sciences.

6. “The” as Part of the Title of an Organization: Lowercase “the” in front of all formal titles unless you know that the organization insists on making the “the” a formal part of its title. “The” is not capped for Rutgers units. Note that the word “the” preceding a newspaper title is lowercased and not italicized. This is the case with all newspaper titles regardless of whether the word “the” appears on the newspaper’s masthead.

Example: He attended The Ohio State University and completed graduate work at the School of Criminal Justice at Rutgers University–Newark. He later worked for the New York Times.

7. Academic Years: Lowercase terms designating academic years. Because it is preferable to avoid gender-specific language, use “first-year student” in place of “freshman” if it does not change or make ambiguous the meaning of the sentence.

Example: first-year student, freshman, senior, or graduate student

A specific class, treated collectively, can be considered a formal group and therefore capitalized. If lowercase is preferred, one simply needs to be consistent within the publication or website.

Example: the Class of 1946

When citing a person’s school and year of graduation after his or her name, the standard form is the name of the school, followed by a space, followed by an apostrophe and the last two digits of the year. Close up space between the acronym/initialism and the year.

Example: Graduate School of Education ’56 or GSE’56

For clarity, use the whole year when referring to early- or late-century class years.

Example: Rutgers College 1905, Rutgers College 1896

Note: See discussion on page 12 regarding acronyms/initialisms used with student/alumnus name, school or college, and class year.

8. Academic Degrees: The preferred style is to spell out all degrees offered by the university: bachelor’s degree instead of B.A. or B.S., master’s degree instead of M.A. or M.S., doctoral degree instead of Ph.D., medical degree instead of M.D. Use either doctorate or doctoral degree, never doctorate degree. Use abbreviations if spelling out the degree is unwieldy or space is limited. Lowercase all academic degrees except when using the abbreviations. Using the word “degree” after the title is strongly preferred for clarity.
Example: bachelor’s degree, bachelor of arts degree, B.A. degree

Some degrees often drop periods in modern usage. If, for example, MBA is used in a publication, it is preferable to drop the periods in other degrees mentioned.

Example: BA and MBA, but B.A. and M.B.A.

Use italics for *summa cum laude, magna cum laude, cum laude.*

9. Titles of Persons: Lowercase titles of persons unless the title is used as an honorific with a last name.

Example: the dean of students; professor of English Rachel Hadas, but Professor Hadas

Use titles and positions (do not include degrees) to identify and explain someone’s standing; a descriptive title adds more context to your communication.

Examples: researcher and oceanographer Scott Glenn; endocrinologist and chief of endocrinology, metabolism, and nutrition Louis Amorosa

Generally do not use honorifics (Mr., Mrs., Dr.). List someone’s full name on first reference and then use his or her last name.

Example: Physicist Karin Rabe was elected to the American Academy of Arts and Sciences. Rabe’s research focuses on the structure and properties of materials.

10. Academic Credentials: Generally avoid listing degrees after a person’s name (otherwise it can lead to alphabet soup). However, you may spell out his or her degree or provide a description.

Example: Joseph A. Barone, who holds a doctor of pharmacy degree...; Maria L. Soto-Green, who holds a medical degree...; Jacob I. Sage, a medical doctor who specializes in...

If it is essential to your communication to indicate doctoral designations, do so after the name by adding “M.D.,” “Ph.D.,” etc. Do not add “Dr.” before the name.

11. Capitalize names of racial, linguistic, tribal, religious, and other human groups. Designations based on color are usually lowercased.

Example: Caucasian, Dane, Hispanic, Latino, Catholic, black, white

12. Titles of Works: In titles, capitalize the first and last words and all nouns, pronouns, adjectives, verbs, adverbs, and subordinate conjunctions. Lowercase articles, coordinate conjunctions, and prepositions (no matter how long).
13. In hyphenated compounds in titles, always capitalize the first element. Subsequent elements are capitalized unless they are articles, prepositions, or coordinating conjunctions, or if the first element is a prefix.


14. Geographical terms that are considered proper names are capitalized. Lowercase descriptive adjectives that are not part of a recognized name.

Example: The North won the Civil War. The northern United States is quite cold in winter. The Pine Barrens are in South Jersey.

15. Lowercase the four seasons: spring, summer, fall, winter.

Electronic Media

1. Use “rutgers.edu” when referring to the university web address, not www.rutgers.edu.

2. http:// (Hypertext Transfer Protocol) and www. (World Wide Web): Before deciding whether to include “http://” and/or “www.” in web addresses in your copy, test the URL to see if you can open the desired webpage without these components. Try to avoid using http:// and www. for webpages because it often is not necessary to enter them as part of a URL, and they clutter copy. Rather, state clearly that the address is a web address.

Example: Please visit oirap.rutgers.edu on the web.

3. Do not underline URLs. Do not format URLs in italics. If you want to draw attention to a URL in a printed piece, consider using bold or a color. The university does not insist on a specific style, since the best choice may vary depending on the design of the publication. For the most part, URLs should be lowercased; check the URL to be sure it is not case-sensitive.

4. It is strongly preferable not to break a URL at the end of a line of text. If possible, rewrite the text to avoid this. If a web address must be broken between two lines, be sure that a hyphen or space is not added inadvertently at the break point.

5. When a URL falls at the end of a sentence, it should be followed by a period. It is assumed that it is common knowledge that the period is not part of the URL. Should you wish to emphasize this and your URL is formatted in bold or in a color, then the period should revert to the previous (often regular/roman or black) type. (This contradicts standard formatting, which calls for punctuation to be set in the type style of the preceding word.)
6. Ewords: Many expressions are cropping up with the letter “e” preceding a familiar word. We recommend closing all such expressions and lowering the word immediately following the “e” prefix.

Example: ebusiness, ecommerce

Note that the “e” in such terms is capitalized when the term appears in a headline, as a stand-alone head, and at the beginning of a sentence.

Example: Ecommerce is important to success in the retail marketplace.

Exceptions are made on a case-by-case basis for official names of organizations, businesses, and other entities that may present their names using a different style.

Example: Pearson eCollege, eBay

7. Social media

When referring to Rutgers content that is part of iTunes U, use the following: Rutgers on iTunes U

When promoting a fan page on Facebook, use the following: Find us on Facebook

When promoting a department on Facebook, use “Department Discipline” on Facebook, i.e., Art History on Facebook, not Department of Art History on Facebook

When promoting Twitter pages, use the following: Follow us on Twitter

8. Website URLs (specifically designated by .com, .org, .edu, .gov, etc.) are lowercased, are formatted in regular/roman type, and are not italicized. Check the URL to be sure it is not case-sensitive.

Examples:
aau.org
cait.rutgers.edu
macys.com

Exception: If a URL starts a sentence, capitalize the first letter (or letters if it is an acronym or initialism.)

Example: AAU.org contains a listing of the 62 member institutions.

NOTE: Many web-based companies have dropped .com as part of their formal names and can be referred to just by the core name as a proper noun, e.g., Facebook, Google, Yahoo, YouTube, etc. Others, such as Amazon.com, still keep .com as part of the formal name;
these should be treated as proper nouns, and therefore capitalized, when you are referring to the corporate entity.

9. Media websites (newspapers, magazines, blogs, etc.) follow formatting conventions for analogous print media and are almost always formatted in italics. It is preferable to indicate when you are referring to the online version of media that also appears in print rather than including the URL.

If you must include a media URL, format it in regular/roman, lowercased. Check the URL to be sure it is not case-sensitive.

Exception: If a URL starts a sentence, capitalize the first letter (or letters if it is an acronym or initialism.)

NOTE: If a media website has .com in its formal name, you may treat the website as a proper noun and capitalize as appropriate.

Examples:
His comments appeared last year in the Economist.
He writes for the online edition of the Economist.
The article and comments are archived at economist.com.
NJ.com, the online home of 12 New Jersey newspapers, including the Star-Ledger, has launched a new web portal devoted exclusively to news and information about Rutgers. Content originated at Rutgers is expected to appear on NJ.com.
Salon.com has a link to the Zimmerli announcement.
The Zimmerli announcement was publicized with a link on salon.com.
She published the blog, the Julie/Julia Project, in Salon. (Although the blog and Salon magazine only appear online, they should be formatted in the type style analogous to printed periodicals if you are not specifying a URL.)

10. Exceptions for text prepared for the media appear on page 41.

Gender-Specific Language

Avoid gender-specific language whenever possible.

<table>
<thead>
<tr>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>chair</td>
<td>chairman/chairwoman/chairperson</td>
</tr>
<tr>
<td>humankind or humanity</td>
<td>mankind</td>
</tr>
<tr>
<td>police officer</td>
<td>policeman</td>
</tr>
<tr>
<td>first-year student*</td>
<td>freshman*</td>
</tr>
</tbody>
</table>

* First-year student is preferred unless it changes the meaning of the text or makes it ambiguous. For example, in saying that “housing is guaranteed to all first-year students,”
there is the possibility that readers may consider an upper-level transfer student to be a first-year student, when, in fact, housing is guaranteed only to freshmen.

Governing Boards

Rutgers has several governing boards. The proper names of all governing boards should be capitalized: Board of Governors, Board of Trustees, the Rutgers University Senate; but the governors, trustees, senate, member of the Board of Governors, senator should be lowercase. All governing boards at Rutgers are headed by a chair and vice chair; do not use chairman, chairwoman, or chairperson.

Italics

Using italics for emphasis in text should be avoided as much as possible. Italics are used for the following:

1. Titles of books, journals, magazines, newspapers, reports, films, television programs (specific episodes are in quotation marks), collections of poetry, and brochures (the last is a preference of this style guide only). Article titles are placed in quotes. Academic course titles are placed in quotes when appearing in narrative text.

2. Media websites (newspapers, magazines, blogs, etc.). Follow formatting conventions for analogous print media, almost always italics. It is preferable to indicate when you are referring to the online version of media that also appears in print rather than including the URL.

If you must include a media URL, format it in regular/roman, lowercased. Check the URL to be sure it is not case-sensitive.

Examples:
His comments appeared last year in the Economist.
He writes for the online edition of the Economist.
The article and comments are archived at economist.com.
NJ.com, the online home of 12 New Jersey newspapers, including the Star-Ledger, has launched a new web portal devoted exclusively to news and information about Rutgers.
Content originated at Rutgers is expected to appear on NJ.com.
Salon.com has a link to the Zimmerli announcement.
The Zimmerli announcement was publicized with a link on salon.com.
She published the blog Julie/Julia Project in Salon. (Although the blog and Salon magazine only appear online, they should be type formatted in the style analogous to printed periodicals if you are not specifying a URL.)

NOTE: Website URLs (specifically designated by .com, .org, .edu, .gov, etc.) are generally lowercased, set in regular/roman type, and not italicized. See page 21 for fuller discussion.
3. Titles of long musical compositions, such as operas. (Titles of songs and short compositions are set in regular/roman type and quoted.)

4. Titles of paintings, drawings, sculpture, and other art

5. Court cases and decisions. The “v” may be in regular/roman or italic if done consistently.

Example: *Brown v. Smith* or *Miranda v. Arizona*. (Also, the *Miranda* case, not the *Miranda v. Arizona* case.)

6. Isolated words and phrases in other languages, if they are likely to be unfamiliar to readers. Set in regular/roman if repeated. If a foreign language word is listed in the main body of Webster’s, it is assumed to be familiar enough not to warrant italics.

7. Scientific names of plants and animals. Capitalize genus, but not species and subspecies.

Example: *Homo sapiens rutgersensis*

8. Terms with special meanings or slang may be italicized the first time they are used. Subsequent uses are in regular/roman.

9. Technical terms, especially when being defined

10. References to words as words or letters as letters may be in italics. Using quotation marks instead of italics is equally acceptable. The usage must just be consistent.

Example: The word *simply* has other meanings. *X* marks the spot. Also acceptable: The word “simply” has other meanings. “*X*” marks the spot.

11. Letters used as mathematical terms

12. Letter grades

13. Use for *summa cum laude, magna cum laude, cum laude*.

**LGBTQA Language**

Use the term LGBTQA when referring to individuals who identify themselves as lesbian, gay, bisexual, transgender, queer, and ally. Using the initialism alone in first reference is acceptable if the audience is an informed audience. If the audience may not know what it means, than write it this way on first reference: LGBTQA (lesbian, gay, bisexual, transgender, queer, ally).
Example: There is a program run by the residents of housing for LGBTQ (lesbian, gay, bisexual, transgender, queer, and ally) students. The LGBTQ community fully supports it.

**Numbers**

1. The general rule is to spell out cardinal and ordinal numbers through nine, i.e., zero through nine, and first through ninth. Use Arabic numerals for 10 and above, and 10th and above. This may cause a paragraph, or even a sentence, to have both words and numerals for numbers. This is fine. For example: She had three cats and 11 dogs.

   Exceptions are made for academic credits, percentages, ages, heights, weights, and other dimensions.

   For ordinal numbers, do not use superscript when typing 10th and above.

   Example: He celebrated the publication of his 15th journal article, not 15th journal article.

2. Academic credits are always expressed in numerals.

   Examples: This is a 3-credit course. The major requires a total of 36 credits.

3. Percentages are always expressed in numerals, and the word “percent” is spelled out. An exception can be made for tables where the percent sign (%) can be used.

   Example: The professor passed 80 percent of the class.

4. Use numerals in ages: a 3-year-old girl, she is 32 years old

5. Numbers at the beginning of sentences must be spelled out.

   Example: Eighty percent of the class passed.

6. Times: Use figures except for noon (12 p.m.) and midnight (12 a.m.).

   Use a colon to separate hours from minutes: 11 a.m., 3:25 p.m.
   Do not use :00 if the time is on the hour. (An exception may be made in formal invitations: Please join us at the afternoon banquet from 11:00 a.m. to 2:00 p.m.)

7. Dates: When citing a specific date, it is helpful to the reader to include the day of the week. Do not abbreviate the days of the week and months.

8. Currency:
5 cents, $1.05, $650,000, $2.45 million
300 Canadian dollars = C$300 or Can$300
5 (euro) cents, €1.05, €650,000, €2.45 million

9. Decades: the 1980s, the ’80s

10. Spell out numbers in casual expressions: Thanks a million.

11. Height, Weight: Use figures for all and spell out inches, feet, pounds, ounces, etc. Hyphenate adjectival forms before nouns.

Examples: He is 5 feet 10 inches tall. The 5-foot-10-inch man. The 5-10 quarterback. The baby weighed 5 pounds, 11 ounces. He is a 235-pound fullback.

*Telephone Numbers*

The preferred form for listing telephone numbers is the following:
732-445-3701, ext. 6409

732-445-3701 x 6301 is also acceptable if space is an issue.

*Plurals and Possessives*

1. The possessive case of singular nouns is formed by the addition of an “apostrophe s” (’s). The possessive case of plural nouns is formed by the addition of an apostrophe only. This applies to proper nouns and common nouns.

Example: Jack’s car, Columbus’s ship, puppies’ tails

Exception: Rutgers’. Use an apostrophe only with the word “Rutgers.” Do not add an extra “s.”

Example: Rutgers’ football team (or the Rutgers football team), Rutgers’ students (or the Rutgers students). (Also see the Proper Names at Rutgers on page 4.)

Other exceptions: Jesus, Moses, and Greek names of more than one syllable ending in “s”

Note: The word “Rutgers” before the name of a school, college, center, institute, program, etc., may or may not include an apostrophe, depending on the writer’s preference. Notable exceptions are Rutgers Business School–Newark and New Brunswick, Rutgers Law School, and the Rutgers School of Dental Medicine, which never take the apostrophe.
Examples: Rutgers’ School of Criminal Justice and Institute of Jazz Studies are based in Newark. The professor presented her seminar at the Rutgers New Jersey Medical School.

2. Single or multiple letters used as words and numbers (whether spelled out or in figures) form the plural by adding “s” alone, so far as it can be done without confusion.

Example: the three Rs, CODs, IOUs, SOSs, the early 1920s

3. Abbreviations ending with a period form the plural with an “apostrophe s.”

Example: Ph.D.’s, M.D.’s, Psy.D.’s

A few abbreviations typically drop the periods in modern usage, in which case the apostrophe is not needed for the plural. If MBA is used in a publication, it is preferable, for consistency, to drop all the periods in other degrees mentioned.

Example: MDs and MBAs, but M.D.’s and M.B.A.’s if the periods are used
Preferred Spellings, Capitalizations, and Usage
Always use the preferred spelling (the first entry in the dictionary) when there is more than one acceptable spelling listed. Example: toward, not towards. Note that exceptions for materials prepared for news media and websites appear on page 41.

A
adviser
aesthetic
affect (see effect): Affect, as a verb, means to influence: The construction will affect traffic for many months to come. Affect, as a noun, is rarely used. It means emotional state: The patient’s depression was indicated by his flat affect.
African American (n.)
African-American (adj.)
All-American
alum (f. or m., singular; use very sparingly and never in formal communications)
alumna (f., singular) Jane is an alumna of Douglass College.
alumnae (f., plural, usually used when referring to women-focused groups) Jane and Mary are alumnae of Douglass College.
alumni (m. or group of men and women, plural) The fraternity’s alumni came back to campus for the event. Jane, Bill, and six other alumni attended the meeting.
alumnus (m., singular) Bill is an alumnus of the School of Social Work.
arachnology
assure (see ensure and insure): Assure means to make sure or certain. He double-checked to assure that the answers were correct.
audiovisual

B
Barnes & Noble at Rutgers
best seller (n.)
best-selling (adj.)
Big Ten (Always spell out “Ten”; never use “10.”)
Big Ten Academic Alliance (formerly known as the Committee on Institutional Cooperation)
black (person)
blog (n. and v.)

C
cablecast
campuswide
catalog (not catalogue)
chair (not chairman, chairwoman, or chairperson)
child care (n. and adj.)
co-chair (this is an exception to the rule to close up words beginning with co)
Cold War
colonial
coursework
CMS (content management system)
coadjutant (not coadjunct)
craftspeople
craftsperson
credits (not credit hours)
cross-cultural
CSS (cascading style sheet)
cum laude
cumulative grade-point average
curriculum, curricula

D
database
day care (n. and adj.)
decision maker or making (n.)
decision-making (adj.)
dial up (v.)
dial-up (adj.)
Division I
Division II
Division III
doctor (see physician)
dual degree (n.)
dual-degree (adj.)

E
ebusiness
ecommerce
effect (see affect): Effect, as a verb, means to accomplish: The new president effected many changes. Effect, as a noun, means result: The effect of the donation was dramatic.
Elite Eight
e-mail
emergita (f. singular) She is a trustee emerita of the board.
emeritae (f. plural, usually used when referring to women-focused groups) The women are trustees emeritae of the Women’s Science Coalition.
emeriti (m. or group of men and women, plural) John and Bill were trustees emeriti of the board. John and Jane were trustees emeriti of the board.
emeritus (m. singular) John is a trustee emeritus of the board.
enewsletter
ensure (see assure, insure): Ensure means to guarantee: Steps were taken to ensure accuracy.

F
Facebook
faculties (plural, when referring to faculty of more than one academic unit)
faculty (may be singular or plural for verb agreement; use “members of the faculty” if necessary to avoid awkward construction) Rutgers faculty (they) seek solutions
for urgent problems. The Rutgers faculty (it) is known for excellence in research. Members of the faculty (they) are organizing the research symposium.

fan page
FAQ (not FAQs) for Frequently Asked Questions
fieldwork
fifth-year student
Final Four
first-year student
fiscal year 2007 (also FY2007; try to reserve FY for financial matters)
follow-up (n. and adj. preceding a noun)
follow up (verb)
Football Bowl Subdivision
Football Championship Subdivision
friend (v.)
full-time (adj. preceding a noun)
full time (after a verb)
fundraise, fundraiser
fundraising (n. and adj.)
FY2013 (or fiscal year 2013)

G
Google
google (v.)
grade-point average
groundbreaking
gymnasiums

H
he or she (not he/she, s/he, or (s)he)
health care (n. and adj.)
High Point Solutions Stadium
high school (n. and adj.)
high-speed (adj.)
high-tech (adj.)
his or hers (not his/hers)
historic (having great and lasting importance)
historical (occurred in the past)
homework
HTML (Hypertext Markup Language)

I
impact (n.): Impact should not be used as a verb. Try using influence or affect instead.
in-depth (adj.)
inpatient
insure (see assure, ensure): Insure is reserved for insurance, i.e., paid policy.
internet
iptv (internet protocol television)
iTunes
iTunes U

J
Jersey Shore
joint degree (n.)
joint-degree (adj.)

L
life cycle
lifelong
lifestyle
lifetime
log in (v.)
login (adj. and noun)
long-standing (adj.)
long-term (adj.)

M
magna cum laude
material (n.)
materiel (n.): equipment, apparatus, or supplies used by an institution
microblog
minicourse
multicast
multimedia
myRutgers

N
NCAA (National Collegiate Athletic Association)
NCAA championship
NCAA tournament
NetID
number-one team

O
on-campus (adj. preceding a noun)
on campus (after a verb)
online
on-site (adj. preceding a noun)
on site (after a verb)
on the Banks
orthopedics
outpatient

P
part-time (adj. preceding a noun)
part time (after a verb)
password
PDF (Portable Document Format)
physician (preferred over doctor when referring to a medical doctor)
physician assistant
podcast
policymaker or policymaking (n.)
policy-making (adj.)
prelaw
premedicine
preveterinary
problem solving (n.)
problem-solving (adj.)
profile page
psychophysical

R
reentry
retweet
romanticism
RSS (Really Simple Syndication)

S
screen-saver
semester (preferred usage; see term)
sign up (v.)
sign-up (n. and adj.)
solid-state (adj.)
social media
Social Security Number
socioeconomic
spin-off (n. and adj.)
spin off (v.)
startup (n. and adj.) (fledgling business)
state house (see separate entry under State References)
statewide
status update
stem cell research
streaming
student-athlete
summa cum laude
supply chain management
Sweet Sixteen
symposia (pl.)

T
tags
term (generally only used when referring to term bills; otherwise, use semester)
theater
third world (n.): Don’t use, unless quoting material. Use developing world instead.
third-world (adj.): Don’t use, unless quoting material. Use developing-world instead.
3-D (n. and adj.)
time frame
timetable
tollbooth
totaled, totaling
turfgrass
tweet
Twitter

U
under way (adv.) Plans are under way to renovate the hall.
unfriend (v.)
universitywide
URL (Uniform Resource Locator; i.e., an individual web address)
username

V
v. or v. (in title of a court case)
versus (not vs.)
vice president

W
wall posting
WeatherWatchers
web
webcast
webpage
website
white (person)
wiki
workforce
workplace
work study (n.)
work-study (adj.)
worldwide
World Wide Web

Z
zip code
Punctuation

Bulleted and Numbered Lists

1. In vertical lists that do not comprise a single sentence: A vertical list is best introduced by a complete grammatical sentence, followed by a colon. After each bullet or number, each entry should start with a capital letter. The entries should carry no punctuation at the end, unless they are complete sentences.

Example:

Other online innovations have also been developed:
• Financial aid application
• Web-based class schedule
• Financial aid awards
• Financial aid requests for documentation
• Loan promissory notes
• Loan counseling
• Online student survey to measure service quality

2. In vertical lists punctuated as a single sentence: A numbered or bulleted vertical list that comprises, with its introduction and entries, a complete sentence begins with an introductory statement followed by numbers or bullets. Each entry starts with a lowercase letter and is followed by a semicolon. A period should follow the final entry.

Example:

We also consider such qualitative factors as
• participation in programs designed for college preparation;
• extracurricular activities;
• community, volunteer, or U.S. military service;
• honors and awards;
• employment;
• family obligations;
• essays;
• special talents; and
• socioeconomic background.

Note: The above styles for punctuating lists are recommendations. One has flexibility in choosing styles for punctuating lists. The goal should be to punctuate lists with style consistency throughout a document.
Commas

1. Series or Serial Comma: Use a comma after each element in a series of three or more.

Example: students, faculty, and administration

Exception: We discourage the use of ampersands (&). However, if an ampersand must be used, there is no comma before an ampersand.

Example: housing, dining & transportation

2. Title abbreviations following a person’s name, such as Jr., Sr., Esq., and roman numerals are not set off by commas.

Example: John J. Jones Sr. and John J. Jones III were poor, but John J. Johns Esq. made a lot of money.

3. Use commas to set off a word or phrase in apposition, unless it has an essential identifying function. (Apposition is when two usually adjacent nouns referring to the same thing are used in a sentence and are essentially interchangeable. In the example below, the person has one wife, Mary; there is no confusion about which wife is referred to, so Mary does not serve an essential identifying function for “my wife” and is set off by commas. The person does have more than one friend, however, so John does serve an essential identifying function for “my friend” and is not set off by commas.)

Example: My wife, Mary, arrived but my friend John did not.

4. In dates, commas are not used to mark off the month and year. If the day is included, the year is set off by commas before and after.

Examples: The meetings were held in April 1967. The events of April 18, 1775, have been celebrated in song and story.

5. Use commas after both a city and state when both are given.

Example: He lived in Bedford Hills, New York, before moving to Georgia.

6. Use a semicolon in lists of names or titles or in other lists that would not be clear if separated by commas only.

Example: Her work combines elements of environmental, civil, and mechanical engineering; human and animal biology; and sociology.

Example: They came from Mendon, Utica, and Point Lookout, New York; Springfield, East Brunswick, and Newark, New Jersey; and Newton, Worcester, and Hull, Massachusetts.
Dashes and Hyphens

There are three common dashes of differing lengths used in formatted copy: em dash (—), en dash (–), and hyphen (‐). The em dash is the longest (the width of an uppercase “M” in the typeface and size being used, which is usually also the point size). The en dash is half the length of the em dash. The hyphen is the shortest.

1. Em dash: Use this dash in most print publications and brochures and online where appropriate to denote an abrupt change in thought or to set off an element added for emphasis, explanation, or digression. The em dash should be typeset closed, i.e., with no extra space before or after the dash.

Example: Tens of thousands of previously unknown proteins—revealed to scientists through the mapping of the human genome—may point the way to the discovery of new drugs to treat disease.

Note: To insert an em dash in Word:
PCs: From the menu, choose Insert > Special Character, then choose the em dash (the larger of the two dash options). The shortcut is Alt + Control + Numberpad Minus Sign (‐).

MACs: From the menu, choose Insert > Symbol, then choose the em dash (the larger of the two dash options). The shortcut is Command (Apple) + Option + Numberpad Minus Sign (‐).

2. En dash: The en dash is another option to denote an abrupt change in thought or to set off an element added for emphasis, explanation, or digression. The en dash is more typically used in text prepared for the media and in some online text. The en dash should be typeset open, i.e., with one space before and after the dash.

Example: Tens of thousands of previously unknown proteins – revealed to scientists through the mapping of the human genome – may point the way to the discovery of new drugs to treat disease.

An en dash is also normally used to separate inclusive dates and numbers. For this use, en dashes should be typeset closed.


In addition, Rutgers uses the en dash in school names and university names.

Example: Graduate School–Camden, Rutgers University–New Brunswick

Note: To insert an en dash in Word:
PCs: From the menu, choose Insert > Special Character, then choose the en dash (the smaller of the two dash options). The shortcut is Control + Numberpad Minus Sign (‐).
MACs: From the menu, choose Insert > Symbol, then choose the en dash (the smaller of the two dash options). The shortcut is Command (Apple) + Numberpad Minus Sign (-).

3. The hyphen is typically used to form compound words, e.g., long-term commitment, self-study, part-time student, spin-off company, screen-saver. It is also used in phone numbers, e.g., 732-445-3710. (See Telephone Numbers on page 26.)

*Hyphenation*

1. In general, modern usage tends toward the closing of prefixes and of compound words that used to be hyphenated. First check the style guide you are following. Then check the dictionary. (Also see Preferred Spellings on page 28.)

2. A hyphen is used after the first of two prefixes or after the first element in a “double” compound adjective.

   Example: Macro- and microeconomics, fourth- and fifth-century art (but “established in the fifth century”)

3. Do not hyphenate an adverb ending in “ly” before an adjective.

   Example: highly popular musician

4. Compound adjectives where the second adjective ends in “ed” are hyphenated.

   Example: good-natured proofreader

5. Other compound adjectives may or may not be hyphenated. Check the dictionary, as many are listed there.

   a. Hyphens should definitely be used to avoid ambiguity.

      Example: personal-computer program, slow-moving van

   b. However, if the meaning of the compound adjective is a universally understood expression, no hyphen is needed.

      Example: the health care system, a high school classroom

   c. Other less common expressions are better hyphenated.

      Example: joint-degree program, advanced-technology center
6. Use hyphens with nouns that represent different and equally important functions when they form a single expression.

Example: city-state, student-athlete

7. The following prefixes are not hyphenated:

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Prefix</th>
<th>Prefix</th>
<th>Prefix</th>
<th>Prefix</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>ante</td>
<td>infra</td>
<td>mini</td>
<td>pro</td>
<td>super</td>
<td></td>
</tr>
<tr>
<td>anti</td>
<td>inter</td>
<td>multi</td>
<td>proto</td>
<td>supra</td>
<td></td>
</tr>
<tr>
<td>bi</td>
<td>intra</td>
<td>neo</td>
<td>pseudo</td>
<td>trans</td>
<td></td>
</tr>
<tr>
<td>bio</td>
<td>macro</td>
<td>non</td>
<td>re</td>
<td>ultra</td>
<td></td>
</tr>
<tr>
<td>co</td>
<td>meta</td>
<td>over</td>
<td>semi</td>
<td>un</td>
<td></td>
</tr>
<tr>
<td>counter</td>
<td>micro</td>
<td>post</td>
<td>socio</td>
<td>under</td>
<td></td>
</tr>
<tr>
<td>extra</td>
<td>mid</td>
<td>pre</td>
<td>sub</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Exceptions: (a) when the second element is capitalized or is a figure, e.g., mid-July, pre-1960s; (b) when there is a homonym, e.g., recover a lost object, but re-cover a couch; and (c) for clarity, when it creates a strange spelling connection (co-chair, not cochair); when there are repeated vowels, such as anti-intellectual or co-op, although even these frequently are now closed.

8. All “self” compounds are hyphenated except when the addition is a suffix.

Example: self-confident, self-reliant, but selfless and selfish

9. Compounds with “well” are hyphenated before the noun unless the expression carries a modifier. Do not use a hyphen if the compound appears after the verb.

Example: well-intentioned person, but very well known man. She is well known.

10. Suffixes are rarely hyphenated, unless particularly cumbersome.

Example: statewide, campuswide, universitywide

Internal and Terminal Punctuation (Type Formatting)

Periods, exclamation points, commas, semicolons, hyphens, and other internal and terminal punctuation should be set in the type style (e.g., bold, italic, regular/roman, color) of the preceding word.

Examples: The professor was quoted in the New York Times. The prize went to Volcanoes of the Deep, a film coproduced by Rutgers. Contact your adviser immediately!
Parentheses

No punctuation should be used before an opening parenthesis. All punctuation except terminal punctuation should be dropped before a closing parenthesis.

Periods and Other Terminal Punctuation

Between sentences, use only one space after the period, question mark, and exclamation point.

Quotation Marks

1. All punctuation marks except the colon and semicolon are always placed within quotation marks.

2. Use double quotation marks for quoted words, phrases, and sentences that are not set apart in block quotations. Use single quotation marks to enclose quotes within quotes.

Example: “Then, for an encore, he sang ‘Yesterday.’”

3. Longer quotations (over three typeset lines) are usually indented and set in smaller type. These block quotations are not enclosed by quotation marks.

4. Article titles are placed in quotes. Academic course titles are placed in quotes when appearing in narrative text. (See Italics for styles of other items on page 23.)

Semicolons and Colons

The first word of a sentence following a semicolon or the first word of a sentence or list following a colon within a sentence should be lowercased. Use only one space after a semicolon or colon.
State References

1. The proper name of the meeting place of the New Jersey legislature in Trenton is the New Jersey State House. Note that “state house” is two separate words, not “statehouse,” as you would find in the dictionary. Use lowercase in generic references.

Examples:
The meeting was at the New Jersey State House.
The state house is a popular field trip destination for New Jersey schoolchildren.

2. When referring to another state’s legislative meeting place, research the proper name.

Example: Maryland State House, Ohio Statehouse, Kentucky State Capitol, State Capitol of Pennsylvania. Proper usage can be found on state legislative and tourism websites.

3. Use the lowercase, generic form for plural references.

Example: The Maryland and New Jersey state houses

4. Always spell out governor, the chief of the executive branch in New Jersey.

Examples: Governor Chris Christie visited Rutgers Tuesday. The governor announced the creation of a task force on school security.

5. Spell out states in full except when providing addresses primarily for the purpose of mailing or in citations, in which case standard U.S. Postal Service abbreviations should be used.

Examples: The Zimmerli Art Museum is located in New Brunswick, New Jersey. Please send all proofs to the editor at 25 Bentley Drive, New Brunswick, NJ 08901.
Style Guide Exceptions for Material Prepared for News Media

The following exceptions to university style apply to materials intended for distribution to the news media. News organizations adhere to Associated Press (AP) style. Using AP style decreases the likelihood of copy errors.

**Comma, in a series:** Use commas to separate elements in a series, but do not put a comma before the conjunction in a simple series. The flag is red, white and blue.

But if an integral element of the series requires a conjunction, place a comma before the concluding conjunction. I want orange juice, toast, and ham and eggs for breakfast.

**“Governor”:** Use the abbreviation Gov. with a proper name. Gov. Chris Christie

**Hyphenation and Dashes:**
School names: Use a hyphen in school names and university names.

Example: Graduate School-Camden, Rutgers University-Newark

Use a hyphen to separate inclusive dates and numbers.


Do not use em dashes in materials promoted to media. (See page 36 for a discussion of em dashes.)

**Months:** Abbreviate the following months when used with a specific date: Jan., Feb., Aug., Sept., Oct., Nov., and Dec. Spell out all months when using alone, or when using with a year and no specific date.

Style Guide Exceptions for Material Prepared for Websites

The entries in the style guide generally apply to text written and edited for websites. Nonetheless, design, readability, editorial, and promotional considerations allow for flexibility when writing and editing text for websites.

Some common web usages at Rutgers that are contrary to the style guide follow:

**Ampersands:** Used in headlines and subheads, they are acceptable.

**Numbers:** Cardinal and ordinal numbers from 0 to 9 and 1st to 9th expressed as digits rather than being spelled out are acceptable.